# Table of Contents

## 1 Introduction

1.1 About this Manual 5  
1.2 Conventions in this Manual 5  
1.3 Archive Player 5  
1.4 System Requirements 6  
1.5 Additional Documentation 7

## 2 Installation and Starting

2.1 Installation 8  
2.2 Starting the Program 9  
2.3 Deinstallation 9  
2.4 Licenses 10  
2.5 Configuration with Configuration Manager 12  
2.5.1 General 14  
2.5.2 Export 15  
2.5.3 VRM Server 16  
2.6 Preparing for the Exchange of Encrypted Data 17

## 3 Operation

3.1 User Interface 19  
3.2 Main Menu 21  
3.2.1 File 21  
3.2.2 Edit 22  
3.2.3 View 22  
3.2.4 Options 23  
3.2.5 Help 25  
3.3 The Monitors 25  
3.3.1 Connection between Recording and Monitor 26  
3.3.2 Viewing the Selected Recording 27  
3.3.3 Timeline 28  
3.3.4 Additional Information and Controls 31  
3.4 File Search 33  
3.4.1 Setting a Filter 34
### Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.4.2</td>
<td>Search Results</td>
<td>35</td>
</tr>
<tr>
<td>3.5</td>
<td>Software Zoom</td>
<td>36</td>
</tr>
<tr>
<td>3.6</td>
<td>Motion Detection</td>
<td>37</td>
</tr>
<tr>
<td>3.6.1</td>
<td>Motion Detection with Camera Presets</td>
<td>39</td>
</tr>
<tr>
<td>3.6.2</td>
<td>Forensic Search</td>
<td>40</td>
</tr>
<tr>
<td>3.6.3</td>
<td>Alarm Message</td>
<td>42</td>
</tr>
<tr>
<td>3.7</td>
<td>Export and Backup</td>
<td>44</td>
</tr>
<tr>
<td>3.7.1</td>
<td>Exporting Recordings</td>
<td>46</td>
</tr>
<tr>
<td>3.7.2</td>
<td>Additional Information</td>
<td>50</td>
</tr>
<tr>
<td>3.7.3</td>
<td>Burning Data to CD or DVD</td>
<td>50</td>
</tr>
<tr>
<td>3.7.4</td>
<td>Backup</td>
<td>51</td>
</tr>
<tr>
<td>3.8</td>
<td>Exiting the Program</td>
<td>53</td>
</tr>
<tr>
<td>4</td>
<td>Contour Design ShuttlePRO V.2</td>
<td>54</td>
</tr>
<tr>
<td>4.1</td>
<td>Introduction</td>
<td>54</td>
</tr>
<tr>
<td>4.2</td>
<td>Installation of Contour Design ShuttlePRO V.2</td>
<td>54</td>
</tr>
<tr>
<td>4.2.1</td>
<td>Requirements</td>
<td>54</td>
</tr>
<tr>
<td>4.2.2</td>
<td>Installation</td>
<td>55</td>
</tr>
<tr>
<td>4.3</td>
<td>Configuring the Keys</td>
<td>56</td>
</tr>
</tbody>
</table>

**Index**

Page 59
1 Introduction

1.1 About this Manual
This manual is intended for persons who will configure and/or operate Archive Player. The manual describes how to operate Archive Player.

1.2 Conventions in this Manual
In this manual, the following symbols and notations are used to draw attention to special situations:

CAUTION!
Security instructions where non-compliance can result in loss of data are marked with this symbol.

NOTICE!
This symbol indicates special features and provides tips and information for easier, more convenient use of the software.

Terms that you can find in the program, such as menu options or commands, are written in bold.

1.3 Archive Player
Archive Player is a piece of software that is used to show, export and back up recorded video sequences. Archive Player indicates the location at which recordings from a specific camera are archived in the system. Recordings can be selectively searched and played back.
If you manage your recordings with VRM Video Recording Manager, you can use Archive Player to view them.
Archive Player is extended by various motion detection algorithms (MOTION+, IVMD, IVA) that facilitate analysis of the recordings.
The export function also provides the option of exporting recordings or extracts from them and burning them onto CD or DVD for use elsewhere.

In a system in which recordings are managed with VRM, Archive Player also offers the option to back up selected data. Archive Player supports the use of the ShuttlePRO V.2 multimedia controller from Contour Design. Together with Archive Player, the Configuration Manager program is also installed, which is used for configuring the system.

### 1.4 System Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows XP Home&lt;br&gt;Windows XP Professional&lt;br&gt;Windows Vista</td>
</tr>
<tr>
<td>CPU</td>
<td>Pentium IV, 3.0 GHz or faster</td>
</tr>
<tr>
<td>RAM</td>
<td>256 MB or more</td>
</tr>
<tr>
<td>Graphics card</td>
<td>NVIDIA Quadro NVS 290 PCIe&lt;br&gt;NVIDIA Quadro FX 370 PCIe&lt;br&gt;ATI FireGL V5600 PCIe&lt;br&gt;NVIDIA Quadro FX 1700 PCIe&lt;br&gt;NVIDIA Quadro FX 3700 PCIe or better</td>
</tr>
<tr>
<td>Network adapter</td>
<td>100 Mbps</td>
</tr>
<tr>
<td>Sound card</td>
<td>Recommended</td>
</tr>
</tbody>
</table>

**NOTICE!**

Install the Configuration Manager program from the installation CD. Doing so ensures that you are using the version that is compatible with Archive Player.
1.5 Additional Documentation

Once Archive Player has been installed, this document is also available as online Help within the program. Depending on the configuration of your system, the following documentation may also be useful:

- **Configuration Manager**
  This configuration program is part of every Archive Player installation.

- **VRM, IVMD, IVA**
  Each program is explained in a separate document.

- **Forensic Search**
  When you purchase a forensic search license, you will be provided with comprehensive documentation on the configuration options.

- **Camera documentation**
  You obtain separate documentation for each camera from the manufacturer.

- **VideoJet, VIP, etc.**
  You obtain documentation for each device from Bosch. This explains the typical device settings.
2 Installation and Starting

2.1 Installation

The configuration program Configuration Manager and Player, the playback program for exported video data, are installed together with Archive Player.

1. Close all other applications before beginning the installation.

2. Insert the installation CD into the computer's CD-ROM drive. The CD runs automatically.
   If the CD does not run automatically, open the index.html page from the root.

3. Select the required language for the user interface.

4. Click one of the entries under Installation Packages to start installing the relevant installation package. You will be guided through the installation of each individual package.

5. When installing individual packages, several installation processes will run one after the other where necessary. During installation, you will be prompted to select target directories for the programs. It is advisable to accept the defaults.

When selecting components, a description for each one is displayed when you hover the mouse cursor over them.

If individual programs are already installed on your PC, you can exclude these from the installation in the Choose Components dialog box.

If you want to use the Archive Player export function, you must activate the Additional elements for export CDs option during installation.

If you want to use the ShuttlePRO V.2 with Archive Player, you must activate the Contour Design ShuttlePRO2 option during installation.

Activate the Update file association option if you wish to open .mpg, .mp2 and .mp4 files automatically with Bosch Player. The assignment is also applied to files already on the PC.
2.2 Starting the Program

After successful installation, you will find the following icons on your desktop:

![Archive Player icon](image)

Double click an icon to start the relevant program.

Archive Player can also be started via the Windows **Start menu** or from within the Configuration Manager program. You can use Configuration Manager to set up user administration. A login dialog box appears, where applicable. Before you can start the program, you must log in here using your user name and the associated password.

**Archive Player and VRM**

If Archive Player is used on a system that uses VRM Video Recording Manager for managing recordings, you have to log in when Archive Player starts up. The login window will be displayed before the program starts. Enter your user name and password here. Confirm your entries by pressing Enter. If required, VRM Configurator can be used to assign rights that restrict the use of some Archive Player functions. Archive Player is also used to create backups of recordings in a system managed by VRM. For more information, please see the **VRM Video Recording Manager** documentation.

2.3 Deinstallation

If you no longer want to use Archive Player on your PC, uninstall the program.

1. Click **Start > Settings > Control Panel**.
2. Double-click Add or Remove Programs.
3. Select the Bosch Archive Player entry.
4. Click Remove.

2.4 Licenses

After installation, you can use the Archive Player program including the search and export functions as a demo version for a period of 30 days.

Archive Player can then still be used without a license for playing back recordings. You will require a license for the additional export function for exporting files and saving to CD or DVD and for backing up VRM data.

You will also require a license to use forensic search with the extended video analysis options (IVMD, IVA) in recordings. The motion detection base module (MOTION+) can also be used without a license.

License management for Archive Player is carried out using the Configuration Manager program on the PC that is to be licensed.

1. Start the Configuration Manager program on the PC you want to license.
2. Click Help > Online Help....
3. In the About Configuration Manager dialog box, click the Licenses tab and then License Viewer....
   You will see the License Viewer window.
4. Make a note of the Installation code (Code 2) entry – the copy-and-paste function is supported. You will need this to generate the activation keys for your license.

NOTICE!

When you purchase products that require a license, you will receive a separate authorization number for each license and workstation; you will also need this number to generate the relevant activation keys.
5. Open the following Website from any PC:
https://activation.boschsecurity.com/
The Bosch Security Systems **Software License Manager**
user interface will appear. The page appears in English
only.

6. If you already have an account, log in.
You can create a new account if you wish. The benefit of an
account is that you can list all of your previous license
activations.
Once you have logged in, the welcome dialog box will
appear.
You can also continue the process without logging in.
Next, you will see the **License Activation** screen.

7. Generate the required activation keys.
8. Return to Configuration Manager.
9. Reopen the **License Viewer** window as described in steps
2 and 3.
10. Click **Activation Key** and enter the first activation key
(Activation Key 1) – the copy-and-paste function is
supported.
11. Click **OK** to save the activation key.
12. Repeat this process to save the second activation key
(Activation Key 2).
   This releases the license version.
You can use the License Viewer at any time to determine which
license version is active on the PC in question.

---

**CAUTION!**
The license is linked to your PC. If you have uninstalled Archive
Player and then want to reinstall it on a different PC, you will
need to request a new activation key.
2.5 Configuration with Configuration Manager

The Configuration Manager program is installed along with the Archive Player program. You can use Configuration Manager to integrate devices into the system and to configure devices and cameras.

**NOTICE!**

Archive Player can only access cameras and devices that have been integrated into the system using the Configuration Manager program.

In systems in which recordings are managed with VRM Video Recording Manager, VRM Configurator handles most of these tasks. However, you will still need Configuration Manager to integrate Archive Player into the VRM system.

The Configuration Manager program comes complete with extensive documentation containing information about the use of the program.

The Configuration Manager program also includes the following settings, which affect Archive Player:

1. In the **Configuration Manager** program, click the **System** tab on the left-hand side.
2. In the tree structure, select **Applications** > **Archive Player**.

![Configuration Manager](image)
3. Select one of the tabs:
   - Section 2.5.1 General, page 14
   - Section 2.5.2 Export, page 15
   - Section 2.5.3 VRM Server, page 16
   Enter the required settings here.

Also make the following additional Archive Player settings in Configuration Manager:

4. In the tree structure, select **General > Directories**.
   You will find the following configuration options on the right-hand side:
   - **Screenshot folder**
     Select the storage location for screenshots that you make with Archive Player.
   - **Recording folder**
     Select the storage location for video recordings that you make with Archive Player.

   If you do not enter anything here, the following default settings are used:
   - %current user%\My Documents\Bosch\VIDOS\Snapshots
   - %current user%\My Documents\Bosch\VIDOS\Recordings

5. In the tree structure, select **General > Hardware Monitors**.
   Hardware monitors are video monitors that are integrated into the system via video decoders. Software monitors are the monitors displayed in the Archive Player playback window. You can use this matrix to permanently connect hardware and software monitors to one another. This means that as soon as a software monitor that is connected in this way is activated in Archive Player, the image is also displayed on the associated hardware monitor.

   For details on this function, see the *Configuration Manager* documentation.
6. In the tree structure, select **Applications > Configuration Manager**.
   On the **Appearance** tab, you can activate the **Prefix device name to camera name** option. In the case of cameras that are integrated into the system via video encoders, the encoder device name is also displayed before the camera name in the camera list.
   The encoder name can therefore be included when you are filtering the camera list (see: **Section Tree Filter**, page 26).

**Grouping Cameras**
Configuration Manager allows you to arrange cameras into clear groups. You can then see the grouping in Archive Player.
For details on this function, see the **Configuration Manager** documentation.

**Configuring Devices**
Use Configuration Manager to configure devices integrated into the system. The settings include:
- Device and camera name
- Passwords for device access
- Display stamping (alarm, camera name, time stamp)
- Device network settings, IP address
- Encoder parameters
- Alarm settings
- Recording settings
- Camera controller

### 2.5.1 General

**Maximum trick mode instances**
Dependant on your hardware's specification, you can select the number of playback instances on which you want to apply trickplay simultaneously.

**Enable smooth playback**
This function is switched on and off here.
Pre-event offset (ms)
Here, you can define the point at which the playback should start by entering the number of milliseconds running up to the event you have selected. If you enter 5000, for example, the playback will always show the five seconds prior to the event.

Animate monitor layout change
This function is switched on and off here.

COM port
If the program is operated via an IntuiKey control panel, enter the number of the COM port here.

2.5.2 Export

Default export format
Here you can select the file format for exports. Select the Sender (Bosch MPEG) option if the data is to be displayed with Archive Player or Player. Metadata and bookmarks are also saved.
Select the Windows (*.wmv) option if the data is to be displayed on a Windows PC, irrespective of the CCTV system. Metadata and bookmarks are not saved.

Default export path
Here you can select the path to the folder to which Archive Player will export recordings. The path can be changed subsequently in Archive Player for individual exports. If you do not enter anything here, the following default setting is used:
%current user%\My Documents\Bosch\VIDOS\Export

Maximum concurrent downloads
Archive Player provides recordings from all available devices in the network locally on a PC and allows the corresponding files to be exported. Under certain circumstances, exporting recordings can result in a heavy network load. For this reason, you can limit the number of concurrent downloads here. This setting depends on both the local network's and the PC's specification.
Maximum download attempts
If a recording cannot be exported at the first attempt, Archive Player repeats the attempt several times. These attempts block other outstanding exports. For this reason, you can limit the number of download attempts here.

Maximum download speed (%)
The download speed can be adjusted for exports in Sender (Bosch MPEG) format. For example, if you enter 100, the download occurs at normal speed, but if you enter 200, it will occur twice as quickly. Select 0 (zero) if all exports are to be carried out at the maximum possible speed. This option does not affect exports in Windows (*.wmv) format.

Resume aborted exports
Select On if interrupted exports in Sender (Bosch MPEG) format are to be restarted when the program has been rebooted. This option does not affect exports in Windows (*.wmv) format.

2.5.3 VRM Server
The settings on this tab only apply to the Archive Player/VRM Server connection. The basic settings for Client/Server environments are configured on the General > Client/Server tab.
For details on this function, see the Configuration Manager documentation.

Connect to server
Activate this option if VRM Video Recording Management is being used on your system.

Server IP address / IP address backup server
Enter the IP address of the computer on which VRM Server has been started and, if necessary, the IP address of the backup server computer.
### 2.6 Preparing for the Exchange of Encrypted Data

To enable playback of encrypted data with Archive Player, you must adapt the settings for the relevant sender using Configuration Manager.

1. Select the **Devices** main tab in the Configuration Manager program and highlight the appropriate senders.
2. Make sure the **File > Advanced Mode** option is active.
3. Select the **Network** tab from the display area, or the **Advanced Network** tab for devices with firmware version 4.0 and better. Activate the **Automatic key interchange** option under **Encryption**.

   Click ![Save Settings](image) to save the settings.

4. Select the **Unit Access** tab.
   Select the **HTTPS** setting from the **Protocol** list field under **Device access**.

   Click ![Save Settings](image) to save the settings.
3 Operation

In the Archive Player program, you have access to all cameras that have previously been integrated into the system using Configuration Manager or VRM Configurator. Both programs allow you to combine cameras into groups, for example according to location. For more information, please see the appropriate documentation.

Archive Player provides the following functions:

- **File search in all archives**
  All recordings from a camera are listed. The recordings can be saved in the local memory of a sender (for example VideoJet X40), on an iSCSI storage system or on your PC’s hard disk. You can limit the search for recordings using filters.

- **View**
  Existing recordings can be played back on your PC. You can rewind and fast forward in a recording at variable speeds.

- **Bookmarks**
  You can set bookmarks at points that are relevant to you. This allows you to quickly find particular sequences in long recordings. The markers for alarm events are displayed and you can leap to them in the same way as you can to the bookmarks.

- **Forensic search in recorded video sequences (function requires license)**
  Recordings can be analyzed for changes and moving objects with the aid of various algorithms. Objects can be filtered according to certain criteria, such as speed, color or direction of movement.

- **Export and backup (function requires license)**
  Recordings can be exported and burnt to CD or DVD. In a system managed by VRM, recordings can be backed up.
3.1 User Interface

1. File search
   (see: Section 3.4 File Search, page 33)

2. Software Zoom
   (see: Section 3.5 Software Zoom, page 36)

3. Motion detection with VCA (Video Content Analysis)
   (see: Section 3.6.2 Forensic Search, page 40)

4. Export/Backup
   (see: Section 3.7 Export and Backup, page 44)

5. Playback window with monitors
   The active monitor is outlined in green.

6. Switches to Viewer
You can increase the space for displaying the search results and the timeline by placing the mouse at the upper edge of the appropriate section until the cursor changes into the following symbol:

With the mouse button held down, drag the upper edge up or down. The section view is increased or decreased and the size of the playback window changes accordingly. The number of monitors being displayed is also adjusted variably. All monitors that can still be displayed in full screen view on the PC monitor are shown in light gray.

**Note:** At least one recording must be selected to alter the display size of the timeline.
3.2 Main Menu

Below are the lists of commands available in the main menu. Some of the functions can also be called up via key combinations or function keys.

3.2.1 File

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Folder...</td>
<td>The selection dialog box for opening a folder is displayed. All recordings saved in this folder will be displayed in the search results.</td>
</tr>
<tr>
<td>Open File...</td>
<td>The selection dialog box for opening mp*-files is displayed. You can use this to select a recording that will then be displayed in the active monitor. Only recordings that have been saved from within a BVIP program or the Web browser view of a camera can be played back.</td>
</tr>
<tr>
<td>Add Search Folder...</td>
<td>The selection dialog box for opening a folder is displayed. Select a folder that contains recordings you want to include in the search with your filter criteria. For example, you can include recordings in your search that have already been burnt to CD. Once you have selected a folder to be included in your search, it will be included in all future searches. When Archive Player is exited, the folder assignments are lost and the folders must be re-added next time you start the program.</td>
</tr>
<tr>
<td>Check Authenticity...</td>
<td>Verifies whether the selected recording has been retrospectively manipulated</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the program</td>
</tr>
</tbody>
</table>
### 3.2.2 Edit

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Set Selection</strong></td>
<td><strong>Start</strong> F5: Sets the start marker for a selection</td>
</tr>
<tr>
<td></td>
<td><strong>End</strong> F6: Sets the end marker for a selection</td>
</tr>
<tr>
<td><strong>Save Screenshots</strong></td>
<td>(P): Saves screenshots from all connected monitors in the specified folder</td>
</tr>
<tr>
<td></td>
<td><strong>Print Screenshots...</strong> (Alt+P): Saves screenshots from all connected</td>
</tr>
<tr>
<td></td>
<td>monitors in the specified folder and prints them on the PC's default printer</td>
</tr>
<tr>
<td></td>
<td><strong>Send Screenshots...</strong>: Saves screenshots from all connected monitors in</td>
</tr>
<tr>
<td></td>
<td>the specified folder and sends them to the selected e-mail addresses</td>
</tr>
<tr>
<td><strong>Export Selection...</strong></td>
<td>(Alt+E): Starts exporting the selection (See also: Section Export markers,</td>
</tr>
<tr>
<td></td>
<td>page 48)</td>
</tr>
<tr>
<td><strong>Add Bookmark...</strong></td>
<td>(B): Adds a bookmark</td>
</tr>
<tr>
<td><strong>Next Event</strong></td>
<td>(Page Up): Leaps to the next event in active playback (bookmark, alarm</td>
</tr>
<tr>
<td></td>
<td>event, protected sequence, video recording etc.)</td>
</tr>
<tr>
<td><strong>Previous Event</strong></td>
<td>(Page Down): Leaps to the previous event in active playback.</td>
</tr>
</tbody>
</table>

### 3.2.3 View

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Single View</strong></td>
<td>F10: Switches between the current monitor layout and a layout with only one</td>
</tr>
<tr>
<td></td>
<td>monitor, namely the active one</td>
</tr>
<tr>
<td><strong>Full Screen with</strong></td>
<td>Controls F11: Toggles between full screen view with controls and window</td>
</tr>
<tr>
<td></td>
<td>view</td>
</tr>
<tr>
<td><strong>Full Screen</strong></td>
<td>F12: Switches between full screen display and window view</td>
</tr>
</tbody>
</table>
### Options

<table>
<thead>
<tr>
<th>Layout</th>
<th>Allows you to select another monitor layout (see: Section Changing the Monitor Layout, page 26)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Watermarking</td>
<td>Switches the display of authenticity information on or off on all monitors</td>
</tr>
</tbody>
</table>

#### 3.2.4 Tricks

<table>
<thead>
<tr>
<th>Trick Mode</th>
<th>Turns on trick mode. Trick mode ensures that all opened recordings can be played back synchronously. If you are using a mouse with a scroll wheel, you can view recordings frame by frame in trick mode. To do this, place the mouse cursor in the timeline below the timescale and turn the scroll wheel. Playback is automatically stopped (paused) during scrolling. Trick mode requires significantly higher memory capacity and computing power. For this reason, the number of cameras used in this mode can be restricted in the Configuration Manager program (see: Section 2.5 Configuration with Configuration Manager, page 12). No audio data is played back in Trick Mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic Leap</td>
<td>Here you can activate individual options, so that you can leap automatically only to specific points in recordings during playback. This allows you to remove uninteresting sections from playback and gain a quick overview.</td>
</tr>
</tbody>
</table>
You have the following options:

- **Activate All**
  Leaps to all points described below in turn.

- **Deactivate All**
  Deletes the checkmarks before the selected options. The automatic leap function is deactivated.

- **Video**
  Leaps to the starting point of the next available recording. This is useful for devices that are set to record only at specific times or under specific conditions.

- **Alarm**
  Leaps to the next alarm event.

- **Protected**
  Leaps to the starting point of the next available recording protection.

### Automatic Monitor Assignment

In the default setting, each recording called up from within the search results is displayed on the active monitor. The active monitor is identified by a green border. The connection to a recording already running on this monitor is terminated. Select this option if each desired recording should be started on a separate monitor in turn. If all monitors displayed in the selected view layout are occupied, the selected recording is started on the monitor with the longest-standing connection.
### 3.2.5 Help

| **Tree Filter** | If this option is activated, an input field for filtering the list is displayed above the camera list (see: Section Tree Filter, page 26). |
| **Show Backup Tracks** | If this option is activated, only the recordings saved via the Backup function will be displayed (see: Section 3.7.4 Backup, page 51). If this option is not activated, any recordings that are not backups will be displayed. |

#### Online Help...
Opens the online Help

#### About...
Provides information about the software version

### 3.3 The Monitors

Archive Player makes one or more software monitor windows available. These can be displayed in various layouts in the playback window.

Each one of these monitors corresponds to a software decoder. To avoid overloading the network and PC, it is possible to limit the number of playback instances in Trick Mode in Configuration Manager (see: Section 2.5 Configuration with Configuration Manager, page 12).

The number specified here does not limit the number of monitors. It defines the number of connections between monitors and recordings that can be established when Trick Mode is activated. No further connections can be established in Trick Mode once the specified number has been reached.

Displays in the various tabs and commands that are triggered via the tabs (for example, software zoom) are always related to the active monitor.

To activate a monitor, click it with the mouse.

The active monitor is indicated by the green outline.
3.3.1 Connection between Recording and Monitor

Connect a recording to a monitor to start playing it back. Connections between a recording and a monitor are established by:

- Dragging a camera from the camera list to the monitor. All cameras integrated into the system are displayed in the camera list. You can make the display clearer by using the name filter (see: Section Tree Filter, page 26).
- Clicking one of the search results. The currently active monitor will be used for the new connection or, if the Automatic Monitor Assignment option is activated, the next monitor will be used.

Connections between a monitor and a recording are terminated by:

- Right-clicking the monitor and selecting Disconnect Replay Session.
- Dragging another camera from the camera list to the monitor.

Tree Filter

This input field is hidden or displayed via Option > Tree Filter. Here you can filter by camera name, to limit the display in the camera list to certain cameras.

1. Enter a search combination in the input field, using letters, numbers and spaces. Only cameras with this combination in their name will be displayed.

2. Click to display all available cameras again.

In Configuration Manager, you can specify that when the camera is connected via a video encoder, the name of this device is automatically placed before the camera name (see: Section 2.5 Configuration with Configuration Manager, page 12).

Changing the Monitor Layout

Archive Player offers various layouts for the monitors. The monitor layout does not depend on the number of connected cameras. Select View > Layout to change the monitor layout.
Select the number and layout of displayed monitors. Predefined layouts are available. The layout automatically adjusts to the available space on the PC monitor. If you alter the display size for search results or the timeline, the selected layout will adjust itself accordingly. If necessary, there are one or two large monitors available.

If you select a monitor layout with fewer monitors, some connections will be terminated.

In Configuration Manager, you can specify under **Animate monitor layout change** that monitor layout changes should be animated. This allows you to trace the position changes of individual monitors (see: *Section 2.5 Configuration with Configuration Manager, page 12*).

To change the layout of individual monitors, hold the mouse button down and drag a monitor to a different position.

**Full Screen Display**

You can switch between the user interface and the full screen view by pressing the **F11** key for display with controls or the **F12** key for video display only.

### 3.3.2 Viewing the Selected Recording

Once an entry has been selected from the search results, playback of the recording starts automatically.

You can drag and drop a camera directly onto a monitor from the camera list. Playback begins at the starting point of the most recent available recording.

**Pause/Play**

Use this button to pause playback of the selected recording and click again to resume playback.

**Previous I-frame**

Leaps back to the previous I-frame.

**Next frame**

Leaps forward to the next frame.

When leaping back, the last I-frame is displayed in each case. An I-frame is a complete picture produced regularly in a video stream, while the individual frames between them only record
the changes. The frequency of I-frames is set on the video sender (details can be found in the manual for the relevant device).

3.3.3 Timeline
The timeline is used for navigation. The green playback marker indicates the time at which the image currently displayed was created.

1 Camera name or file name (active monitor in bold)
2 Timescale
3 Period represented by the selected recording
4 Show timescale in more detail
5 Show timescale in less detail
6 Bookmarks
7 Playback marker
8 Marked area

Periods for which a recording is available are displayed in light gray.
The period displayed in the timescale can be changed:
- You can move the period displayed by moving the mouse along the timescale with the left mouse button held down.
- The displayed period can be shown in more or less detail by:
  - Clicking one of the magnifying glass icons in the right-hand margin
  - Placing the mouse cursor in the timescale above the timeline and turning the scroll wheel.
When the timescale is shown in enough detail, you may see other colored markers in the timeline. These are system alarms. Recording for these alarms is activated under **Recording Profiles** in Configuration Manager or via the Web browser view of the devices. System alarms are, for example, alarms via the alarm input (red marker) or alarms triggered when the video signal is interrupted (black marker).

To view a different period, select a different recording from the search results or click another gray marker.

If several recordings are displayed, you will see a corresponding track with the relevant markers in the timeline for each monitor.

### Video Scratching

Video scratching is useful for quickly searching large amounts of video data, for example if you are looking for one specific event.

To do this, drag the green playback marker above the camera track to the left or right with the left mouse button held down. During dragging, the I-frames on the associated monitors are updated, enabling a quick overview of the highlighted area.

### Popup Menu

Right-click the camera tracks to open the following popup menu:

<table>
<thead>
<tr>
<th>Popups</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Zoom</strong></td>
<td></td>
</tr>
<tr>
<td> </td>
<td></td>
</tr>
<tr>
<td>Add Bookmark...</td>
<td></td>
</tr>
<tr>
<td>Delete Bookmark</td>
<td></td>
</tr>
<tr>
<td>Set Selection Start</td>
<td></td>
</tr>
<tr>
<td>Set Selection End</td>
<td></td>
</tr>
<tr>
<td>Erase</td>
<td></td>
</tr>
<tr>
<td>Protect</td>
<td></td>
</tr>
<tr>
<td>Unprotect</td>
<td></td>
</tr>
<tr>
<td>Export Selection</td>
<td></td>
</tr>
</tbody>
</table>

### Zoom

An additional submenu is opened that allows you to select the period displayed in the timeline.
Add Bookmark...
Adds a bookmark at the position of the playback marker. The bookmark is added for all tracks.
A dialog box appears, in which you can enter a brief explanation.

Delete Bookmark
Clicking an existing bookmark with the right mouse button gives you the option of deleting this bookmark. The bookmark is deleted for all tracks.

Set Selection Start
Adds a selection start marker at the position of the playback marker.
Selection start markers can also be set from the main menu or by pressing F5.
Selections are memorized when you switch to the Export module.

Set Selection End
Sets the end of a selection.

Note:
- Selections can also be created by moving the mouse cursor over an area of the timeline whilst holding down the left mouse button.
- Selections are removed by clicking the timeline.

Erase (for VRM systems only)
Deletes the previously selected video sequence from the memory. The deletion cannot be undone.

Protect (for VRM systems only)
Protects the previously selected video sequence from deletion. Protected sequences are indicated by a red marker.

Unprotect (for VRM systems only)
Removes protection for a sequence.

Export Selection (only with licensed Export function)
Exports the selected sequence for all camera tracks displayed in the timeline.
If recordings are managed via VRM Video Recording Manager, some of the functions listed above may be limited due to the user rights assigned via the VRM system.
### 3.3.4 Additional Information and Controls

#### Information
Here, you can see the time at which the recording was made.

Enter another time and press Enter. The playback marker leaps to the relevant position and playback starts.

The current playback speed is displayed.

#### Control wheel (fast forward/rewind)
Fast forward or rewind the recording.
To do this, drag the control wheel to the left or right with the mouse button held down. The further you drag, the faster the recording is fast forwarded or rewound.

The control wheel can be locked in place for fast forwarding or rewinding a recording at a specific speed over a prolonged period of time. To do this, drag the green rectangle downward with the mouse at the position corresponding to the required speed. The rectangle will remain locked in place and the recording will fast forward or rewind until the rectangle is dragged upward again or until you click **Start**.

#### Add bookmark...
Sets a bookmark at the current position. The bookmark is added for all tracks.
A dialog box appears, in which you can enter a brief explanation.

#### Previous
The playback marker leaps back to the nearest point in the recording that corresponds to the selection in the list field.
This list field is used to select which points will be leaped to when the arrow icons are clicked. The following items are available:

- **All**
  (All points in the list)

- **Video**
  (The start of every new recording)

- **Bookmark**
  (Every bookmark)

- **Alarm**
  (Every alarm event)

- **Protected**
  (The start of every protected recording range)

- **Profile**
  (The start of every new VCA profile)

- **Frame**
  (Every I-frame)

**Next**
The playback marker leaps forward to the next point in the recording that corresponds to the selection in the list field.

**Start export**
Starts exporting the selection

**Save screenshots**
Saves screenshots from all connected monitors in the specified folder

**Print screenshots...**
Saves screenshots from all connected monitors in the specified folder and prints them on the PC's default printer

**Send screenshots...**
Saves screenshots from all connected monitors in the specified folder and sends them to the selected e-mail addresses
3.4 **File Search**

Here, you can search for recordings made within a particular time interval. You can set additional filters for the storage location and camera for your search. Select **File > Add Search Folder...** to include other recordings in the search.

1. Scrolls back one month
2. Selected month
3. Scrolls forward one month
4. Marked days
5. Filters according to data source
6. Filtering start and end times

As soon as you change one of the parameters for the file search (for example you select a different camera), a new search is automatically initiated.
### 3.4.1 Setting a Filter

When you start Archive Player, the current month is shown in the file search tab.

1. Click ‹ or › to display the previous/next month.

2. Click a day to highlight it
   or
   hold down the left mouse button and move the mouse over the desired days to select a longer period.
   The selected period is highlighted in green.

3. Hold down the SHIFT key to expand a time period you have already selected. Scroll forward or back a month in the calendar, if necessary.

4. You can enter a start and end time.
   If the selected period covers several days, the start time applies to the first selected day and the end time to the last. This allows you to accurately limit the selected period.

5. The **Filter**: drop-down list allows you to limit the search to particular storage locations.

6. Select a camera from the camera list
   or
   select several cameras by holding down the **Ctrl** or **Shift** key while clicking them.
   If cameras are grouped in folders, for example by installation location, you can select a folder. In this case, recordings from all cameras in the folder will be searched and displayed.
   You can make extensive lists clearer by filtering (see: *Section Tree Filter, page 26*).

As soon as you have finished the camera selection, the search for recordings begins. All recordings produced in the selected period using the selected camera(s) and stored at the selected location are listed as search results.

The camera itself does not have to be ready for operation or currently installed for existing recordings to be viewed. Only the devices on which the recorded data is stored (for example video sender with local storage medium, VRM) must be available in the network.
**Note**: If you have changed the name of a camera but recordings from it are still stored in the system under the old name, these recordings are listed under the old camera name. However, the camera itself is marked as not available.

### 3.4.2 Search Results

Sort the saved recordings by clicking one of the column headers (**From**, **To**, **Source** or **Info**). A second click reverses the sort order. Use the scrollbars to scroll through the list.

In the first column, the storage location for the recording is indicated by an icon:

- ![Recording icon](image)
  - Recording is located on your PC

- ![Recording icon](image)
  - Recording is located in a VRM system or on NVR (Network Video Recorder)

- ![Recording icon](image)
  - Recording is located locally on the storage medium of an installed video sender (for example VideoJet X40)

  ▶ Click an entry.

  Playback of the corresponding recordings is started.
3.5 **Software Zoom**

The digital zoom tool allows you to display an enlarged view of a view port.

1. Click **Activate zoom** to use the software zoom on the image on the active monitor.
2. Move the mouse into the green rectangle. When the mouse cursor changes, you can hold down the left mouse button and move the rectangle to display a different view port on the active monitor.
3. Drag any corner or side of the rectangle with the left mouse button held down to change the size of the selection rectangle. The view port on the active monitor changes accordingly.
4. Click **Reset view port** to display the selection rectangle at the preset size and in the center.
5. Click **Deactivate zoom** to show the entire image from the recording on the active monitor again.
3.6 Motion Detection

Various algorithms can be used to detect moving objects on recordings. This enables positions in which movements have been recorded to be found quickly, even in large volumes of video material.

The precondition is

- that the relevant motion detection algorithm was already activated during recording and
- that metadata was included in the material recorded. To do this, the relevant option must be activated for the device under **Recording Profiles** in Configuration Manager.

Only sections highlighted as sensitive areas (shaded in yellow) during recording can be searched for movements.

The following algorithms are available:

- **MOTION+**
  License-free algorithm that detects movements in highlighted image areas. The sensitivity and minimum object size can be modified.

- **IVMD** and **IVA**
  These algorithms must be licensed after a demo period of 30 days (see: **Section 3.6.2 Forensic Search, page 40**).
  When using these algorithms, objects to be detected as moving can be defined exactly and filtered out according to factors such as size, color, direction or speed.

In addition to motion detection, other algorithms are available for use as search filters:

- The **Alarm Search** algorithm lists all system alarms in the search results that were active during recording. The alarm type is displayed in the Info column of the results list. These alarms are indicated in the timeline by different colored markers (see: **Section 3.3.3 Timeline, page 28**).

- You can use the **Alarm Message** algorithm to limit the search to alarms indicated by a particular message (see: **Section 3.6.3 Alarm Message, page 42**).
These settings can only be edited if at least one monitor has been assigned a recording.

1. Saved configuration
2. Displays the outlines of moving objects on the active monitor, depending on the algorithm presets. Yellow outlines indicate a detected movement. Red outlines indicate a movement that has triggered an alarm event.
3. Displays the current configuration for the active monitor.
4. Enables changes to the configuration. Depending on each selected algorithm, additional configuration options are available via the popup menu of the active monitor and, where applicable, a separate configuration window.
5. Algorithm dropdown list
6. Opens a window for saving changed configurations.
7. Starts the search for moving objects according to the settings selected for the active monitor.
8. Profile selection (from IVA 4.0)
3.6.1 Motion Detection with Camera Presets

If a motion detection algorithm is configured and active during recording, the corresponding metadata is saved together with the video data.

For devices and cameras with firmware version 4.0 or above, the relevant option for saving metadata must be activated during recording.

The alarm events generated with this preset are displayed in the recording as follows:

1. Select a camera from the camera list in the File search tab.
2. Select a recording from the list of search results.
3. Switch to the Motion detection tab:  
   The Search algorithm display indicates which algorithm was active during the original recording.
4. Highlight the area to be analyzed in the timeline.
5. Click the icon to search the highlighted selection for movements that have generated an alarm event.

Recognized events in the camera track are highlighted in yellow:

All recognized events are shown in the list area beneath the timeline. Here, you will find information on the time and trigger for the alarm, among other things.

6. Click the icon to display the motion detection configuration.
3.6.2 Forensic Search
If you want to search a recording with other filter settings, for example due to new findings, algorithms with self-defined settings can also be used for analyzing the sensitive area. The **MOTION+** algorithm is always available. **MOTION+** detects movements in a highlighted area of the camera image. The sensitivity and minimum object size can be set.

To continue using **IVMD** and **IVA** after the demo period of 30 days has expired, you must purchase a license and enter the license code using Configuration Manager. Using the **IVMD** and **IVA** algorithms, objects can also be filtered according to their direction of movement, speed, color or behavior.

**NOTICE!**
After purchasing the license you will receive the *Forensic Search* documentation including detailed information on configuration options for the various algorithms.

**Selection and Configuration**
1. Select a camera from the camera list in the **File search** tab.
2. Select a recording from the list of search results.
3. Switch to the **Motion detection** tab: ![Motion Detection](Image).
4. Highlight the area to be analyzed in the timeline.
5. Select an algorithm from the **Search algorithm** list.
6. Click the ![Outline](Image) icon to display outlines of moving objects. Objects can only be selected as such if a movement is detected. Accordingly, objects cannot be detected if playback is paused.
7. Click the ![Configuration](Image) icon to display the current configuration.
8. Click the ![Setting](Image) icon to change the settings for the selected algorithm. The monitor frame is now displayed in yellow.
9. To open the popup menu, right-click in the active yellow-framed monitor. The popup menu offers different menu items, depending on the selected algorithm. A separate configuration window is also displayed for certain algorithms.

10. Change the algorithm parameters according to your requirements.

11. Click the icon to save the settings as a preset. You can use saved presets for other recordings at a later date.

12. In the **Save Configuration** dialog box, select the number (1, 2, 3 or 4) under which you want to save the preset. Give the preset a descriptive name.

13. Click the icon to save the preset.

14. Click 1, 2, 3 or 4 to apply a saved preset to the active monitor.

15. Click the icon to search the highlighted selection for movements that have generated an alarm event according to the selected preset. Recognized events in the camera track are highlighted in yellow:
All recognized events are shown in the list area beneath the timeline. Here, you will find information on the time and trigger for the alarm, among other things.

16. Click ⏪ or ⏫ to leap to the previous or next alarm in the recording.

**NOTICE!**
The detected alarm events are not saved if you terminate the connection between the recording and the monitor. It is possible, however, to set a bookmark in the corresponding positions. Bookmarks are saved.

### 3.6.3 Alarm Message
You can use this algorithm to search metadata for the messages with which alarms are automatically indicated. These messages are displayed in the **Info** column in the search results. This allows you to further restrict extensive search results.

**Note:** These messages must not be confused with the alarm messages that can be entered manually under **Display stamping** in Configuration Manager or via the Web browser view of the devices.

1. Select a camera from the camera list in the **File search** tab.
2. Select a recording from the list of search results.
3. Switch to the **Motion detection** tab: ![Motion detection](images/motion_detection_icon.png).
4. Highlight the area to be analyzed in the timeline.
5. Select the **Alarm Message** algorithm from the **Search algorithm** list.
6. Click the ![Algorithm settings](images/algorithm_settings_icon.png) icon to change the settings for the algorithm. The monitor frame is now displayed in yellow. The configuration window is opened.
7. Select the **Configuration** tab.
Specify the length of the section to be marked for export by entering the relevant time span for the time before and after the message was displayed.
8. Select the **Search** tab. Enter the text you wish to search for; you may also search with partial text and placeholders. The following texts are saved as messages with alarms, for example:
- Name of the VCA task
- Texts entered via IVA Task Script
- Texts showing tamper alarms (for example, very noisy scenes)
- Texts showing system alarms (alarms via alarm inputs, for example)

9. You can save these settings in the configuration window via **Configuration > Save to File...** and use them for another search via **Load from File...**.

10. To open the popup menu, right-click in the active yellow-framed monitor. The popup menu offers the following menu items:
- **Show OSD**
  Switches the display of the alarm message on the monitor on or off
- **Select OSD Font**
  Opens the dialog box for selecting a font type and size for displaying the alarm message

11. Click the **icon** to save the settings as a preset. You can use saved presets for other recordings at a later date.

12. In the **Save Configuration** dialog box, select the number (1, 2, 3 or 4) under which you want to save the preset. Give the preset a descriptive name.
13. Click the icon to save the preset.

14. Click , , or to apply a saved preset to the active monitor.

15. Click the icon to search for overlays in the marked selection.

Recognized events in the camera track are highlighted in yellow:

16. Click or to leap to the previous or next overlay in the recording.

3.7 Export and Backup

The export module allows you to export all recordings to your PC or to a different storage location in the network.

After successful export, you can burn recordings to CD or DVD.

In a system managed by VRM, you can also use this module to back up selected recordings in the system.

NOTICE!

To use this module, you must purchase a license. The Export/Backup tab is no longer available once the demo period has expired.
1 Calendar
2 Export Details
3 Export Status
4 Camera list with filter displayed
5 Search results
6 Destination
7 Export Format
8 Additional Information
9 Export items
10 Start disk creation
11 Selection of CD/DVD drive
Exporting Recordings

1. Click the Export/Backup tab: 📚. You will see the export module.
2. Search for the desired recordings.
   (see: Section 3.4 File Search, page 33) The search results are listed.
3. Select the required format for the files to be exported from the Export Format list:
   - **Sender (Bosch MPEG)**
     Metadata is also saved
   - **Windows (*.wmv)**
     Metadata is not saved
   - **iSCSI backup**
     Note: This option is only valid for backing up (see: Section 3.7.4 Backup, page 51).

4. Click the icon next to the Destination field.
   You will see the Select destination folder dialog box.

5. Select the folder in which you want the exported files to be saved.

   Below the Destination field you will find information on how much memory space is available at the destination.

   The selected destination is also valid for exports that you initiate via the timeline popup menu or the main menu. If you do not enter anything here, the export path set in Configuration Manager applies.

6. Click Export items:

   Exporting of the files begins.

   Under Export Status you can see a list of all recordings that are currently being exported. Precise information about an export can be found under Export Details for a selected entry.

7. If you want to pause the export of individual files, highlight the corresponding entry under Export Status and click the Pause export icon: 

8. If you want to cancel the export of individual files and delete those files, highlight the corresponding entry under
Export Status and click the Delete export job and associated files icon: .
Recordings that are being burnt onto CD or DVD cannot be deleted.

9. Click the icon again to continue the export.

**CAUTION!**
In ring mode, it is possible that the originally selected recording will have been overwritten during the pause. In this case, the export cannot be continued.

**NOTICE!**
No exports are possible at loads above 50% (CPU display in menu bar turns red).

10. All exported recordings are listed under Export Status.
    After successful export, the message Finished is displayed under Export Status in the Info column.
11. If necessary, repeat steps 2 to 8 for other cameras or for a different period.
    The exported recordings are now stored at the destination location.

**Export markers**
Recordings to be exported can be marked during playback so that the export module will only export a particular section of it.
1. Search for a recording (see: Section 3.4 File Search, page 33) and start playback.
2. Press F5 when the playback marker is at the point where you want the export to start.
   The export start time is set.
3. Press F6 when the playback marker is at the point where you want the export to stop.
   The export end time is set.
You can also use the popup menu in the timeline to set start and end markers or highlight the required area by dragging with the mouse button held down. The highlighted area is shown in green on the timeline:

4. Click **Export Selection** in the popup menu of the timeline. The highlighted sections are exported in the format preset under **Default export format** in Configuration Manager. If you have not entered anything under **Destination** on the Export/Backup tab, data is exported directly to the folder entered under **Default export path** in Configuration Manager. Information on the exported sequences is displayed in a new window.

5. Click the ✔️ icon to close the window.
6. If necessary, switch to the export module to monitor the export process.

**Possible Causes of Delays or Errors when Exporting**
- Some devices can only establish one playback connection. This may already be in use.
- The recording no longer exists (overwritten in ring mode, file has been manually deleted).
- The network connection was broken during the export process.
- A recording you want to continue exporting has been opened on the PC in the meantime.
- The connecting point in a recording you want to continue exporting can no longer be found in the video stream.

Depending on the settings in Configuration Manager, Archive Player can make several attempts to export the files.

**WARNING!**
Do not delete the original recording data until you have made sure that the relevant data has been completely exported.
3.7.2 Additional Information

The name of a file to be burnt to a CD or DVD is derived from the names of the device and camera used to create the recording.

The file name can be edited before the burning process.

1. Click an entry in the list of exported files.
   The Additional Information entry is now displayed above the Export Format information.

2. Enter your details (max. 32 characters) and click the icon.
   The file will be burnt to CD or DVD under the name entered.

3.7.3 Burning Data to CD or DVD

1. Insert a blank writable CD or DVD into the burner on your PC.

2. Select the drive:

3. Under Export Status, select the recordings you want to burn onto CD or DVD. To do this, click in the box next to an entry to mark it with a check:

   You cannot select a recording until the export of that recording is complete.

   The free memory space remaining on the CD or DVD is displayed next to the button.
4. Enter additional information for the selected entries (see: Section 3.7.2 Additional Information, page 50).

5. Click **Start disk creation**

This button is only available if at least one recording has been selected for export to CD. If one burning process is currently in progress, another cannot be started.

The data is burnt onto CD or DVD.

In addition, a program is burnt onto the CD or DVD that can be used to play back the video data on another PC.

### 3.7.4 Backup

Archive Player allows recordings managed by VRM to be saved on a backup LUN that is also managed by VRM. This makes it possible to merge data that is divided among several LUNs into one file. This data can be saved to tape drives, for example, using the relevant backup software, and then returned to the system managed by VRM from there. As the backup is also managed by VRM, the necessary read and write accesses are regulated such that simultaneous recordings are not affected.

**Procedure for using the backup function:**

1. Set up at least one Backup LUN in VRM. Details on setting up a backup LUN are available from the VRM documentation.

2. Integrate VRM into your system using **Configuration Manager**, so that Archive Player has access to the recordings managed by VRM (see: Section 2.5 Configuration with Configuration Manager, page 12).

3. Click the **Export/Backup** tab: 📀.

You will see the export module.

4. Search for the desired recordings.

(see: Section 3.4 File Search, page 33)

The search results are listed.

5. Select the **iSCSI backup** format from the **Export Format** list.
6. Select the IP address of the required backup LUN as the destination. The address is displayed in IP/Target-ID/LUN-ID format.

7. Click **Export items:**

   The data backup process begins.

   Under **Export Status** you can see a list of all recordings that are currently being backed up. Precise information about a backup can be found under **Export Details** for a selected entry.

8. If you want to pause the backup of individual files, highlight the corresponding entry under **Export Status** and click the **Pause export** icon: 

9. If you want to cancel the backup of individual files and delete those files, highlight the corresponding entry under **Export Status** and click the **Delete export job and associated files** icon: 

10. Click the **icon again to continue the backup.

### CAUTION!

In ring mode, it is possible that the originally selected recording will have been overwritten during the pause. In this case, the backup cannot be continued.

11. All backed up recordings are listed under **Export Status.** After successful backup, the message **Finished** is displayed under **Export Status** in the **Info** column.

12. If necessary, repeat steps 4 to 10 for other cameras or for a different period.

   The backed up recordings are now saved on the backup LUN.
3.8 Exiting the Program

Select **File > Exit** from the main menu when you want to exit Archive Player.
4 Contour Design ShuttlePRO V.2

4.1 Introduction

Archive Player supports the use of the ShuttlePRO V.2 multimedia controller from Contour Design.
Among the many advantages of using the multimedia controller are the intuitive operation, easy scrolling and the option to view videos image by image.
Contour Design ShuttlePRO V.2 is installed with Archive Player as an optional component. Following installation, ShuttlePRO is linked to a USB connection. ShuttlePRO can then be used with Archive Player.

4.2 Installation of Contour Design ShuttlePRO V.2

4.2.1 Requirements
- Archive Player version 2.23 or above
- Free USB connection
  It is preferable to use a direct connection. Connection is possible via an active hub. Do not use a USB adapter.
### 4.2.2 Installation

**NOTICE!**
Uninstall other multimedia controllers before starting the installation.

Contour Design ShuttlePRO V.2 is installed together with Archive Player. In order to use ShuttlePRO, activate the **Contour Design ShuttlePRO2** option when installing Archive Player.

![Bosch Archive Player 03.00.0002.0 Setup](image)

Select components to install:
- Archive Player
- Additional elements for export
- Contour Design ShuttlePRO
- Update file association

Space required: 63 MB

After installation, connect ShuttlePRO with one of your PC's USB connections. ShuttlePRO can now be used with Archive Player.

You will find more precise information on configuring the keys and control wheel on the following pages.

Do not change the configuration, as it cannot be restored.
4.3 Configuring the Keys

You can still use Archive Player with the mouse and keyboard when Contour Design ShuttlePRO V.2 is connected. The corresponding keys and function keys are listed in the right-hand column of the following table.
<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Start export</td>
<td>Starts exporting the selection</td>
</tr>
<tr>
<td>2</td>
<td>Scroll up in the list</td>
<td>The list field shows the previous entry in the list</td>
</tr>
<tr>
<td>3</td>
<td>Set Selection Start</td>
<td>Sets the start marker for a selection</td>
</tr>
<tr>
<td>4</td>
<td>Previous</td>
<td>The playback marker leaps back to the nearest point in the recording that</td>
</tr>
<tr>
<td></td>
<td></td>
<td>corresponds to the selection in the list</td>
</tr>
<tr>
<td>5</td>
<td>Backward</td>
<td>Starts playing back the selection backward</td>
</tr>
<tr>
<td>6</td>
<td>ESC</td>
<td>Cancels an entry you have already started</td>
</tr>
<tr>
<td>7</td>
<td>Zoom out</td>
<td>Shows the timescale in less detail</td>
</tr>
<tr>
<td>8</td>
<td>Pause/Play</td>
<td>Use this button to pause playback of the selected recording and click again</td>
</tr>
<tr>
<td></td>
<td></td>
<td>to resume playback.</td>
</tr>
<tr>
<td>9</td>
<td>Zoom in</td>
<td>Shows the timescale in more detail</td>
</tr>
<tr>
<td>10</td>
<td>Add bookmark...</td>
<td>Sets a bookmark at the current position. The bookmark is added for all</td>
</tr>
<tr>
<td></td>
<td></td>
<td>tracks.</td>
</tr>
<tr>
<td>11</td>
<td>Play forward</td>
<td>Starts playing back the selection forward</td>
</tr>
<tr>
<td>12</td>
<td>Next</td>
<td>The playback marker leaps forward to the next point in the recording that</td>
</tr>
<tr>
<td></td>
<td></td>
<td>corresponds to the selection in the list</td>
</tr>
<tr>
<td>13</td>
<td>Set Selection End</td>
<td>Sets the end marker for a selection</td>
</tr>
<tr>
<td>14</td>
<td>Scroll down in the list</td>
<td>The list field shows the next entry in the list</td>
</tr>
<tr>
<td>15</td>
<td>Save screenshots</td>
<td>Saves screenshots from all connected monitors in the specified folder</td>
</tr>
</tbody>
</table>
### Control Wheel

<table>
<thead>
<tr>
<th>Left positions:</th>
<th>Right positions:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rewind</td>
<td>Forward</td>
</tr>
<tr>
<td>1 x 0.5</td>
<td>1 x 0.5</td>
</tr>
<tr>
<td>2 x 1</td>
<td>2 x 1</td>
</tr>
<tr>
<td>3 x 2</td>
<td>3 x 2</td>
</tr>
<tr>
<td>4 x 4</td>
<td>4 x 4</td>
</tr>
<tr>
<td>5 x 8</td>
<td>5 x 8</td>
</tr>
<tr>
<td>6 x 16</td>
<td>6 x 16</td>
</tr>
<tr>
<td>7 x 32</td>
<td>7 x 32</td>
</tr>
</tbody>
</table>

Hold the control wheel in position 7 to further increase the running speed.

### Trade Marks

Contour is a registered trade mark of Contour Design, Inc. ShuttlePRO2 is a trade mark of Contour Design, Inc.
Index

A
Animation of layout change 15
Archive 18

B
Bookmark
  setting 31, 57
Burning data to CD/DVD 50

C
Camera
  grouping 14
Camera list 20
Checking authenticity 21
COM port 15
Configuration Manager 12
CPU load 20

D
Destination 47
Devices
  configuring 14
Documentation
  additional 7
Download speed 16

E
Encryption 17
Export
  delays 49
  deleting 48, 52
  errors 49
  file name 50
  jobs 47, 52
  pausing 47, 52
  status 48, 52
Export format (Archive Player) 15
Export Markers 48
Export markers 52
Export path (Archive Player) 15
Export to CD 50
Export to DVD 50

F
F11 key 27
F12 key 27
F5 key 48
F6 key 48
File search 33
Filters 34
Forensic Search 40
Full Screen 22, 27

G
Green outline 25

I
I-frame 27
IVA 37
IVMD 37

L
Layout 23
Leap filter 23
License 10
Limit
  download attempts 16
  file export 15
  trickplay instances 14
Login 9

M
Magnifying glass 28
Monitor
  green outline 25
Monitor assignment, automatic 24
Monitor layout 26
Motion detection
  own settings 40
  presets 39
MOTION+ 37

O
Operation 18
Outlines 38

P
Password 9
Pause 27
Play 27
Playback 26, 27
Playback marker 28
Playback speed 31
Program
  exiting 21
  starting 9
Protect 30
R
Recording
  storage location 13
Resuming exports 16
S
Search algorithm 40, 42
Search results 35
Selection 30
Snapshot
  storage location 13
Software 25
Software Zoom 36
Symbols 5
System alarm 29, 37, 43
T
Time of recording 31
Timeline 28
Trick Mode 23
Trickplay 14
  maximum number 25
V
Version number 25
View 18
View port tool 36
Volume 20
VRM 9, 16
W
Watermarking 23
Z
Zoom, digital 36